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Introduction 
The purpose of this walkthrough is to illustrate to the user how an mXrap application can be built to 

analyse a dataset. The walkthrough gives an overview on the different tools which can be created in 

mXrap. This manual is set up to be a step-by-step guide for app building. 

This walkthrough will be looking at an imported excel database (in the form of a .csv file) which 

contains values for Rock Mass Ratings (RMR) related to various geological lithologies. Once imported 

into mXrap, this database will then be manipulated using various tools in the Settings and Analysis 

window.  

This application will enable the user to view CDF and PDF charts of RMR values for various lithologies. 

It will also illustrate how to build the frontend for the app. 
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Structure of Walkthrough 
The walkthrough follows a step-by-step structure. Each step shows how the particular tool is built in 

the Settings Window with a brief description of why the tool is being built. The process followed to 

visualise these built tools in the Analysis Window is then illustrated.  

After introducing the data that the app will use and discussing the importance of understanding the 

content of the database, the walkthrough will introduce the Settings Window followed by a few 

Settings Tools and then the Analysis Window followed by an Analysis Tool. This will serve as an 

introduction to the basic method of tool creation used throughout the rest of the walkthrough. 

After building all of the necessary settings and analysis tools, we will introduce marker tools to colour 

the displayed data, as well as interface tools in which we will compile all of our work into an 

application. 

Finally, the walkthrough will cover how to open the newly created app and set it up for future use. 

Understanding the Data 
Most commonly, the file type imported into mXrap will be in a .csv format (csv stands for comma-

separated values). It is advised that the developer open the database in a program like Excel before 

building the app and to make sure that the context of the contents in the database are well 

understood. 

In this case, we have a .csv file that contains four columns to represent rock quality per lithology. 

The data was obtained from borehole data from several boreholes, with an RMR calculated for each 

10m section of borehole. The .csv is saved in the root folder under \#data\Rock Properties Example. 

 

The columns represent the following 

• holeid – Unique ID given to each borehole. There are several boreholes 

• from – Start of the 10m section, measured in metres from surface in the negative z-direction 

• to – End of the 10m section, measured in metres from surface in the negative z-direction 

• STRAT – The dominant lithology type per borehole section 

• RMR – Rock Mass Rating per depth 
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1. Importing the CSV file into mXrap 

Introduction to the Settings Window 
The Settings window is where the application tools are built. The right combination of created tools in 

the Settings window will form the backbone of the visual representations and calculations to be 

performed on the imported database.  

The Settings Tools will be saved in the root folder under the directory:  

#Beta Modules/IGM Rock Property Statistics Visualisation  

Each step in the Settings window will be saved numerically eg Step 1 – Read CSV 

Open up the mXrap Launcher 

 
In the mXrap Launcher 
Left Click on the Config Root Switch dropdown and select the site root 
Left Click  on the User Role Switch dropdown and select the Home/Admin user role 
Double left click on the *Home/*Admin app to open the Settings window 
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This is the Settings Window. Whenever new Settings Tools are created, the same process applies 
Left click *New in the tool tree to bring up the tools available for creation 
Left click the tool to be created 

 
Once the tool is created, the first step is always to save the tool 
It is useful to give the tool a short, descriptive name 
In this example, the tools are given a Step number to make it easy for the reader to understand 
the flow of the process 
Left click Save As in the bottom right corner of any tool 
Choose an appropriate folder location in which to save the tool as well as a tool name 
 
Note: For this example, the folder location and tool name will be given for every tool created 

 
Once saved, the tool will appear under the appropriate folder in the tool tree 
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Settings Step 01– Creating the CSV tool and Importing a CSV into mXrap 
An Import CSV tool navigates to the directory where the CSV table is stored. These tables are normally 

stored in the site’s mXrap root by the user.  

Create and Save an Import CSV tool  
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 01 – Read CSV 

 
Left Click on the Input File Browse button 
In the Popup Window, navigate to the Rock Properties CSV file location 
Double Click on the file to add it in as the Input File 
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The columns will now be added in the same sequence as they appear in the CSV file 
Left Click on the Columns tab to open it 
For each column: 

• Left Click on the Add Column button 

• Give the column the appropriate name (as seen in the CSV file) 

 
Once the columns have been added, their type needs to be correctly assigned 
Left Click on the Columns tab to open it 
For each column: 

• Left Click on the Type dropdown 

• In the dropdown, Left Click the appropriate input type 
The following inputs are “Number” type: From, To, Eq_RMR 
The following inputs are “Text” type: BHID, Lithology 
 
Note: If an ID consists only of numbers, the ID type can be selected. In our case, since the ID’s are a 
mixture of text and numbers, we need to select text. 
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The CSV Format will now be entered 
Left Click on the CSV Format tab to open it 
 
Left Click on the File Must Exist check box  
This means that the app will show an error if the file is not found in the selected location 
 
Under File Type, Left Click on the Table of Columns: Delimited fields toggle 
This is appropriate as the input file is in fact a CSV 
 
Under File of Columns, Left Click on the Skip the first N plain lines box and change it to 1 
Since the CSV files contain headings, skipping the first line means mXrap won’t attempt to read 
the headings as data 

 
Left Click on the Results tab to view the imported file.  
The Import Results dialogue will show any errors if the file could not be loaded as configured 
 
Note: The File Row column is automatically added by the Import CSV tool 

 
Save the Tool 
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Settings Step 02 – Variables tool for importing .csv’s 
The following variables tool allows the user to choose which csv to import into the application. Note 

that the databases need to maintain the same format to be uploaded successfully.  

Create and Save a new *Variables tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 02 – Variables 

 
Left Click on the Values tab to open it 
Left Click on the Add New Variable dropdown 
In the New Text Name popup window, type in “Filename” 
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In the Filename variable, Left Click the File to load toggle 
This allows the values above to be set to a file location 
Left click on the Value and Default checkboxes to select them 
 
For the Value and Default fields 
Left click on the Browse buttons  
In the Popup Window, navigate to the Rock Properties CSV file location 
Double Click on the file to add it in as the Value and Default 
 
Note: This variable will be editable by a user in the application. To avoid the user accidentally 
losing the file location, the default is set to easily navigate the user back to the original input file 
location. 

 
Save the Tool 
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Settings Step 01 Continued – Linking the Filename variable into the Import CSV 

Open the Read CSV tool created earlier   
Left click on the Link button next to the Input File box 

 
In the popup window, the Inputs now need to be selected 
Under the Tables section, Left Click on the Step 02 – Variables table 
Now, under the Columns in Table section, Left Click on the Filename column 
Left Click on the Use Selected Column button to link the variable in 

 
The variable should now be linked in as follows 

 
Save the Tool 
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Introduction to Analysis Window 
The Analysis Window is where the data that’s been imported and manipulated in the Settings Window 

is displayed in the form of Charts, Table Views and 3D Views. These are also the visual elements that 

will be incorporated in to the frontend of the app. 

The Analysis Tools will be saved in the root folder under the directory:  

#Beta Modules/IGM Rock Property Statistics Visualisation  

Each step in the Analysis window will be saved alphabetically eg Step A – Full Dataset Tableview 

In the Settings window menu 
Left Click on the Workspace dropdown menu 
Left Click on Analysis Window  
 
Note: This will open the Analysis window in which Table Views, Charts and 3D Views can be 
created. 
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To create a new Chart/Table View/3D View: 
Left click *New and choose the tool to create 
Left click the Configure Page button at the bottom left of the screen 
 
In the Configure Page popup 
Left click on the Save As button 
In the Folder textbox, navigate to the same directory used for the Settings Window tools 
In the Name textbox, give the Analysis tool an appropriate name 
 
Note: For this example, the folder location and tool name will be given for every tool created 
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To view the Saved tools created in Analysis View 
Left click on the *mXrap button 
Left click on the Show Tabs button 
In the Visible Tabs popup, navigate to and tick the folder in which the tools are saved 
This will open a new tab showing all the created tools 
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Analysis Step A – Creating a Table View for the Imported CSV 

Create and Save a new *Table View 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step A – Full Dataset Tableview 

Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Columns Table tab 

• Left click on the Table button 
o In the Choose the Table to View popup, navigate to the Read CSV Table 

• Left click on the Filter button 
o In the Set the default Filter popup, navigate to *All Rows 

• Left click on the ID button 
o In the Set ID popup, set the ID to Read CSV 

• In the Columns Tree, tick all the columns under the CSV table  
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The Tableview should look something like this 

 
Left Click the Configure Page button and Save the Tool 
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Application Progress (Section 1) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

The file has been imported and a variable created to enable the user of the app to change the input 

file from within the application. The file can also be viewed in the Analysis Window through a 

tableview. 

 

In the next section, a Distinct Table will be created which will show each distinct lithology type 

contained within the database. 
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2. Creating a Distinct Table for the imported Geological Lithologies 

Settings Step 03 – Creating a Distinct Table for Lithology 
Using the values for Lithology in the imported csv file a Distinct Table, independent of the imported 

CSV table, is created to show all the unique lithologies from the original table. 

Create and Save a new *Distinct Table tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 03 – Distinct Lithology Table 

 
Left click on the Input Table button and in the Table popup, select the Read CSV table 
Left click on the Input Filter button and in the Filter popup, select the *All Rows column 
 
Tick the Generate a Row ID named button 
Tick the Write the new ID back to the Input Table button 
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Left Click on the Add a column button 
In the New Distinct Column popup, navigate to the Lithology column of the Read CSV table 
When prompted, give the New Distinct Column an appropriate name, in this case “Lithology” 

 
Save the Tool 
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Analysis Step B – Viewing the Distinct Table for Lithologies 

Create and Save a new *Table View 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step B – Distinct Lithology Tableview 

Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Columns Table tab 

• Left click on the Table button 
o In the Choose the Table to View popup, navigate to the Distinct Lithology Table 

• Left click on the Filter button 
o In the Set the default Filter popup, navigate to *All Rows 

• Left click on the ID button 
o In the Set ID popup, set the ID to Lith_ID 

In the Columns Tree, tick the Lithology column under the Distinct Lithology Table 

 
The Tableview should look something like this 

 
Left Click the Configure Page button and Save the Tool 
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Settings Step 04 – Variables tool enabling tick boxes for the Distinct Table 
This variable will allow the user to tick and untick which lithology to be visualised. 

Create and Save a new *Variables tool  
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 04 – Tick Table (to be used for filtering on lithology) 

 
Left click on the Change Host Table dropdown, and left click on the Host in another table button 
When prompted if all other tools should be redirected, left click on the Yes button 
In the Choose New Table popup, navigate to the Distinct Lithology Table 
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Left click on the  Columns tab 
Left click on the Use as Row ID button 
Under the Tables tree, navigate to the Distinct Lithology Table created in Step 3 
Under the Columns in Table tree, navigate to the Lith_ID column 

 
Left click on the Add Column button 
In the dropdown, left click on Filter  
When prompted for a filter name, name the filter “Ticks” 
Right click on the newly created filter 

• Left click Select Underlay Column 

• In the Underlay for Ticks popup, under the Tables tree, navigate to the Distinct Table 

• In the Underlay for Ticks popup, under the Columns tree, select “All Rows” at the top of 
the tree 

 
Save the Tool 
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Analysis Step B Continued – Adding Ticks Variable to the Distinct Lithology Table 

Open the Distinct Lithology Tableview   

 
Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Columns Table tab 

• Left click on the Tick column button to toggle it 

• Left click on the Ticks button 
o In the Set Column to use for Ticks popup, navigate to the Ticks column created in 

Step 4 

 
 

 
The Tableview should look something like this 

 
Left Click the Configure Page button and Save the Tool 
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Application Progress (Section 2) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

A distinct table has now been created to show the types of lithology contained in the database. A ticks 

filter column has also been added. These changes are reflected in a newly created tableview. 

 

In the next section, a table map will be used to map the values for the ticks column in the distinct table 

over to the CSV table.  
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3. Linking the two tables using a Table Map 

Settings Step 05 – Creating a Table Map from the CSV table to the Distinct Lith table 
The aim of a table map is to compare selected columns in two tables (In this case, the csv table and 

the distinct Lithology table) and to perform an action once a comparative condition is met. In this case 

we’re assigning the ticks from the Distinct Lithology Table to the original CSV table. 

Create and Save a new *Table Map tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 05 – Map Ticks (Distinct Lithology table to Complete table) 
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Left click to Toggle the Map first exact matches value 
 
Note: The aim is to map the lithologies of the CSV table (Step 1) to the distinct table (Step 3), 
mapping only the first exact matches, adding a column for the Ticks filter created in Step 4. 

 
In the Primary Table section 

• Left click the Table button, in the Primary Table popup navigate to the Read CSV table  

• Left click the Filter button, in the Primary Filter popup navigate to *All Rows 

• Left click the Values button, in the Primary Values popup navigate to Lithology  
 
In the Foreign Table section  

• Left click the Table button, in the Foreign Table popup navigate to the Distinct Lithology 
table  

• Left click the Filter button, in the Foreign Filter popup navigate to *All Rows 

• Left click the Values button, in the Foreign Values popup navigate to Lithology  

 
In the Mapped Foreign Columns section 
Left click on the Add an extra button 
In the New Foreign Extra popup, navigate to the Ticks column created in Step 04 
When prompted, name the extra “Ticks” 

 
Save the Tool 
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Analysis Step C – Creating a Table View showing which Lithologies are “Ticked” 

Create and Save a new *Table View 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step C – Complete Table with Ticks Tableview 

Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Columns Table tab 

• Left click on the Table button 
o In the Choose the Table to View popup, navigate to the Read CSV table 

• Left click on the Filter button 
o In the Set the default Filter popup, navigate to *All Rows 

• Left click on the ID button 
o In the Set ID popup, set the ID to Read CSV 

In the Columns Tree, tick the Lithology column under Read CSV and the Ticks column under Map 
Ticks 

 
Note: Ticking and unticking the various lithologies in the Distinct Lithology table will now show 
whether or not a row is included or excluded in the Complete Table just created. 

 
The Tableview should look something like this 
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Note: Changing the ticks column in the Distinct Lithology Table will now indicate whether or not a 
Lithology is included or not in the new table. The use of this will become apparent later on in the 
walkthrough. Effectively this will allow the user to toggle wich lithologies are of interest. 

 
Left Click the Configure Page button and Save the Tool 
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Application Progress (Section 3) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

The ticks variable has now been mapped over to from the Distinct Lithology Table to the Read CSV 

table using a table map. The influence of this has been demonstrated in a newly created tableview. It 

can be seen that changing the ticks in the Distinct Lithology Tableview changes the Ticks column values 

in the Complete Table (ticks filtered) Tableview. 

 

In the next section, basic row calculations and accumulations will be used to create a CDF chart for the 

Lithologies.  
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4. Creating a CDF table and chart for the Lithologies 

Settings Step 06 – Row calculations to return the LithID as a number for CSV table 
This row calculation simply gives a unique ID for each of the Lithologies in the CSV table. This is done 

so we can order the CSV table using the numbers in the unique ID column. 

Create and Save a new *Row Calculations tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 06 – Change LithID to Number (for Complete Table) 

 
Left click on the Table button 
In the Table popup, navigate to the Read CSV table 
 
In the Equation will generate dropdown, select Numbers 
 
Note: If the equation is set to generate a Number instead of Numbers, it will only generate a single 
value. In this case, the desired outcome is the conversion of each Lith_ID as a number instead of 
an ID. 
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Left click on the Inputs tab to open it 
Left click on the Add Input button 
Left click on the Column toggle to select it 
Left click on the Source button, in the Choose Column for popup, navigate to the Lith_ID 
Type in the Name of the input as “Lith_ID” 

 
In the Equation box, type the following code: 
Return Lith_ID; 
 
Note: Recall the Input Name set earlier was Lith_ID. What this calculation does, is call up the 
Lith_ID column for each row of the Read CSV table. The input is read in as an ID, and then returned 
as a number. 

 
To check that the Syntax of the code is correct, left click the Check Syntax button 
This will open the Errors tab and show whether or not the Syntax is valid 

 
Save the Tool 
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Settings Step 07 – Using an Accumulation tool to create a CDF table sorted per lithology 
This accumulation will count the RMR values for each lithology. 

Create and Save a new *Accumulation tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 07 – CDF for Complete Table (Grouped by Lithology) 

 
Left click on the Input tab to open it 
Left click on the Table button. In the Table popup, navigate to the Read CSV table 
Left click on the Filter button. In the Filter popup, navigate to *All Rows 
Left click to toggle the Compute each group independently value 
Left click on the Group by column button. In the Group first by Column popup, navigate to the 
Lithology column 
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Left click on the Computation tab to open it 
Left click on the Order by column button. In the Order by column popup, navigate to the Eq_RMR 
column 
Tick the Count box under the Simple Computations section 
Left click on the Perform Accumulations On button. In the Values popup, navigate to Eq_RMR  

 
Left click on the Normalisation tab to open it 
Left click on the Divide by total number of elements in group option to toggle it 

 
Left click on the Output tab to open it 
Tick the Generate progressive results for the input table box 

 
Save the Tool 
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Settings Step 08 – Row calculations to return LithID as a number for Distinct Lith table 
Similarly, to the previously built Row Calculation, this Row Calculation will give an ID to each lithology 

however this time in the Distinct Lithology Table. 

Create and Save a new *Row Calculations tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 08 – Change LithID to Number (for Distinct Table) 

 
Left click on the Table button 
In the Table popup, navigate to the Distinct Lithology Table 
 
In the Equation will generate dropdown, select Numbers 
 
Note: If the equation is set to generate a Number instead of Numbers, it will only generate a single 
value. 
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Left click on the Inputs tab to open it 
Left click on the Add Input button 
Left click on the Column toggle to select it 
Left click on the Source button, in the Choose Column for popup, navigate to the Lith_ID 
Type in the Name of the input as “Lith_ID” 

 
In the Equation box, type the following code: 
Return Lith_ID; 
 
Note: Recall the Input Name set earlier was Lith_ID. What this calculation does, is call up the 
Lith_ID column for each row of the Read CSV table. The input is read in as an ID, and then returned 
as a number. 

 
To check that the Syntax of the code is correct, left click the Check Syntax button 
This will open the Errors tab and show whether or not the Syntax is valid 

 
Save the Tool 
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Settings Step 09 – Accumulations tool to Number the Lithologies in the Distinct Table 
This accumulation counts the number of entries under each lithology. 

Create and Save a new *Accumulation tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 09 – Count Number of Lithologies (with Min and Max) 

 
Left click on the Input tab to open it 
Left click on the Table button. In the Table popup, navigate to the Distinct Lithology table 
Left click on the Filter button. In the Filter popup, navigate to *All Rows 
Left click to toggle the Compute as one dataset value 
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Left click on the Computation tab to open it 
Left click on the Order by column button. In the Order by column popup, navigate to the Change 
LithID to Number row calculation output column from Step 08 
Tick the Count box under the Simple Computations section 
Left click on the Perform Accumulations On button. In the Values popup, navigate again to the 
output from the row calculation in Step 08 (LithID to Number) 
Tick the Minimum and Maximum boxes 

 
Left click on the Output tab to open it 
Tick the Export final results to another table box 
Left click on the Table button, in the Export Table popup, navigate to the Distinct Lithology Table 

 
Save the Tool 
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Analysis Step D – Creating a CDF chart for All Lithologies 

Create and Save a new *Chart 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step D – CDF per Lithology Chart 

Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• Left click on the Add button 

• In the Series Name text box, give the series an appropriate name 
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Left click on the Data tab to open it 

• Left click on the Table button 
o In the Table popup, navigate to the Read CSV table 

• Left click on the Filter button 
o In the Filter popup, navigate to *All Rows 

• Left click on the ID button 
o In the Set ID popup, set the ID to Read CSV 

• Left click on the X button 
o In the X popup, set the X-Values to the Eq-RMR for the Read CSV table 

• Left click on the Y button 
o In the Y popup, set the Y-Values to the Count for CDF for accumulation created in 

step 07 

• Tick the Multiple Lines Group By box 

• Left click on the Multiple Lines Group By button 
o In the Group (1) popup, set the Group to the Lithology under the Read CSV 
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The Charts should look something like this  

 
Tick the Lines box to show the distribution as lines and untick the Marker as box to remove the 
marker dots 
The Chart will now look like this 

 
Left Click the Configure Page button and Save the Tool 
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Analysis Step E – Creating a CDF chart for the Ticked Lithologies  

Create and Save a new *Chart 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step E – CDF per Lithology (ticks filtered) Chart 

Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• Left click on the Add button 

• In the Series Name text box, give the series an appropriate name 
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Left click on the Data tab to open it 

• Left click on the Table button 
o In the Table popup, navigate to the Read CSV table 

• Left click on the Filter button 
o In the Filter popup, navigate to Ticks filter under the table map created in Step 05 

• Left click on the ID button 
o In the Set ID popup, set the ID to Read CSV 

• Left click on the X button 
o In the X popup, set the X-Values to the Eq-RMR for the Read CSV table 

• Left click on the Y button 
o In the Y popup, set the Y-Values to the Count for CDF for accumulation created in 

step 07 

• Tick the Multiple Lines Group By box 

• Left click on the Multiple Lines Group By button 
o In the Group (1) popup, set the Group to the Lithology under the Read CSV 
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As before, tick the Lines box and untick the Marker as box to get the distribution in line form 
The chart will look like this  
 
Note: The Titles and Panel tab and the Axes tab in the Configure Page popup can be used to give 
the chart a title as well as naming the axes. 

 
Note: Ticking the Lithologies in the Distinct Lithology Table will now change which of the 
Lithologies are shown in the Chart. Later, Markers will be added to allow easier differentiation of 
which lines represent which lithologies 

 
Left Click the Configure Page button and Save the Tool 
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Application Progress (Section 4) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

A CDF plot for the Lithologies has been drawn using a combination of row calculations and 

accumulations. Two new charts have been created, one of which has the added functionality of being 

filtered by the ticks column in the Distinct Lithology Table. 

 

 

In the next section, key statistical values for each lithology will be determined and displayed in a 

tableview. 
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5. Calculating the Statistics per Lithology 

Settings Step 10 – Accumulating the statistics for each lithology 
The following accumulation determines key statistics for each of the lithologies. 

Create and Save a new *Accumulation tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 10 – Count Number of Lithologies (with Min and Max) 

 
Left click on the Input tab to open it 
Left click on the Table button. In the Table popup, navigate to the Read CSV table 
Left click on the Filter button. In the Filter popup, navigate to *All Rows 
Left click to toggle the Compute each group independently value 
Left click on the Group by column button. In the Group first by Column popup, navigate to the 
Lithology column 
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Left click on the Computation tab to open it 
Left click on the Order by column button. In the Order by column popup, navigate to Lithology 
Tick the Count box under the Simple Computations section 
Left click on the Perform Accumulations On button. In the Values popup, navigate to Eq_RMR 
Tick the Average, Minimum, Maximum, Standard Deviation and Median boxes 

 
Left click on the Output tab to open it 
Tick the Export final results to another table box 
Left click on the Table button, in the Export Table popup, navigate to the Distinct Lithology Table 
Left click on the Column to Match button, in the Export Group popup, navigate to the Lithology 
column 

 
Save the Tool 
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Analysis Step F – Creating a Table View for the Statistics per Lithology 

Create and Save a new *Table View 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step F – Statistics per Lithology Tableview 

Left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Columns Table tab 

• Left click on the Table button 
o In the Choose the Table to View popup, navigate to the Distinct Lithology Table 

• Left click on the Filter button 
o In the Set the default Filter popup, navigate to *All Rows 

• Left click on the ID button 
o In the Set ID popup, set the ID to Lith_ID 

In the Columns Tree  

• Tick the Lithology column under the Distinct Lithology Table 

• Tick all the Statistics columns created in Step 10 
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The Tableview should look something like this 

 
Left Click the Configure Page button and Save the Tool 
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Application Progress (Section 5) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

Key statistical values for each lithology has been determined using an accumulation tool. The statistical 

values for each lithology can be seen in a newly created Statistics per Lithology Tableview 

 

 

In the next section, a PDF distribution for each lithology will be obtained and displayed by means of 

charts. 
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6. Creating PDF charts for the Lithologies 

Settings Step 11 – Creating a Row Calculation to sort RMR data into bins 
The goal of this Row Calculation is to sort the RMR values into bins. Each bin is characterised by the 

lithology it represents and therefore contains RMR values that particular lithology only. 

Create and Save a new *Row Calculations tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 11 – EQ_RMR Bins 

 
Left click on the Table button 
In the Table popup, navigate to the Read CSV table 
 
In the Equation will generate dropdown, select Numbers 
 
Note: If the equation is set to generate a Number instead of Numbers, it will only generate a single 
value.  
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Left click on the Inputs tab to open it 
Left click on the Add Input button 
Left click on the Column toggle to select it 
Left click on the Source button, in the Choose Column for popup, navigate to the Eq_RMR 
Type in the Name of the input as “EQ_RMR” 

 
In the Equation box, type the following code: 
Return Math.floor(EQ_RMR); 
 
Note: The Math.floor() function returns the largest integer less than or equal to a given number. 

 
To check that the Syntax of the code is correct, left click the Check Syntax button 
This will open the Errors tab and show whether or not the Syntax is valid 

 
Save the Tool 
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Settings Step 12 – Accumulations tool created for the PDF of the RMR values 
This accumulation will count the values for RMR grouping the values by bins as well. 

Create and Save a new *Accumulation tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 12 – PDF Complete table (Grouped by liths and bins) 

 
Left click on the Input tab to open it 
Left click on the Table button. In the Table popup, navigate to the Read CSV table 
Left click on the Filter button. In the Filter popup, navigate to *All Rows 
Left click to toggle the Compute each group independently value 
Left click on the Group by column button. In the Group first by Column popup, navigate to the 
Lithology column 
Left click on the other Group by column button. In the Group second by Column popup, Sort 
EQ_RMR into Bins row calculation output from Step 11 
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Left click on the Computation tab to open it 
Left click on the Order by column button. In the Order by column popup, navigate to the Eq_RMR 
column 
Tick the Count box under the Simple Computations section 
Left click on the Perform Accumulations On button. In the Values popup, navigate to Eq_RMR  

 
Left click on the Output tab to open it 
Tick the Generate progressive results for the input table box 

 
Save the Tool 
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Settings Step 13 – Creating an offset for the PDF chart using Row Calculations 
This row calculation will offset the bars on the PDF chart which will increase the ease of visualisation. 

Create and Save a new *Row Calculations tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 13 – EQ_RMR Bins (+ lith offset) 

 
Left click on the Table button 
In the Table popup, navigate to the Read CSV table 
 
In the Equation will generate dropdown, select Numbers 
 
Note: If the equation is set to generate a Number instead of Numbers, it will only generate a single 
value. 
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Left click on the Inputs tab to open it 
Left click on the Add Input button 
Left click on the Column toggle to select it 
Left click on the Source button, in the Choose Column for popup, navigate to the the Sort 
EQ_RMR into Bins output from the Step 11 Row Calculation output 
Type in the Name of the input as “EQ_RMR_bin” 
 
Left click on the Inputs tab to open it 
Left click on the Add Input button 
Left click on the Column toggle to select it 
Left click on the Source button, in the Choose Column for popup, navigate to the Lith_ID 
Type in the Name of the input as “Lith_ID” 
 
Left click on the Inputs tab to open it 
Left click on the Add Input button 
Left click on the Variable toggle to select it 
Left click on the Source button, in the Choose Variable for popup 

• Under the Table section, navigate to the Distinct Lithology Table 

• Under the Columns in Table section, navigate to the Maximum obtained from the Step 09 
accumulation 

Type in the Name of the input as “Lith_numb” 

 
In the Equation box, type the following code: 
return EQ_RMR_bin + Lith_ID/Lith_numb; 
 
Check the syntax 

 
Save the Tool 
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Analysis Step G – Creating a PDF Chart of all Lithologies  

Create and Save a new *Chart 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step G – PDF per Lithology Chart 

As before, left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• Left click on the Add button 

• In the Series Name text box, give the series an appropriate name 
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Left click on the Data tab to open it 

• Left click on the Table button 
o In the Table popup, navigate to the Read CSV table 

• Left click on the Filter button 
o In the Filter popup, navigate to *All Rows 

• Left click on the ID button 
o In the Set ID popup, set the ID to Lith_ID 

• Left click on the X button 
o In the X popup, set the X-Values to the Sort EQ_RMR into Bins Row Calculation 

output from step 11 

• Left click on the Y button 
o In the Y popup, set the Y-Values to the Count for the PDF Complete table 

accumulation created in step 12 

• Tick the Multiple Lines Group By box 

• Left click on the Multiple Lines Group By button 
o In the Group (1) popup, set the Group to the Lithology under the Read CSV 
o In the Group (2) popup, set the Group to the Sort EQ_RMR into Bins Row 

Calculation output from step 11 
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The Chart should look something like this 

 
Left Click the Configure Page button and Save the Tool 

  



mXrap – Rock Properties App Creation Walkthrough 

65 
 

Analysis Step H – Creating a PDF Chart for the Ticked Lithologies  

Create and Save a new *Chart 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step H – PDF per Lithology (ticks filtered) Chart 

As before, left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• Left click on the Add button 

• In the Series Name text box, give the series an appropriate name 

 
Left click on the Data tab to open it 

• Left click on the Table button 
o In the Table popup, navigate to the Read CSV table 

• Left click on the Filter button 
o In the Filter popup, navigate to Ticks filter under the table map created in Step 05 

• Left click on the ID button 
o In the Set ID popup, set the ID to Lith_ID 

• Left click on the X button 
o In the X popup, set the X-Values to the Sort EQ_RMR into Bins Row Calculation 

output from step 11 

• Left click on the Y button 
o In the Y popup, set the Y-Values to the Count for the PDF Complete table 

accumulation created in step 12 

• Tick the Multiple Lines Group By box 

• Left click on the Multiple Lines Group By button 
o In the Group (1) popup, set the Group to the Lithology under the Read CSV 
o In the Group (2) popup, set the Group to the Sort EQ_RMR into Bins Row 

Calculation output from step 11 
 
Note: This chart differs from the chart in Step G only in the filter it uses. 
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The Chart should look something like this. 
 
Note: This chart changes depending on the ticks in the Distinct Lithology Table 

 
Left Click the Configure Page button and Save the Tool 
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Analysis Step I – Creating a PDF Chart for the Lithologies (Including an Offset)  

Create and Save a new *Chart 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step I – PDF per Lithology (ticks + offset) Chart 

As before, left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• Left click on the Add button 

• In the Series Name text box, give the series an appropriate name 

 
Left click on the Data tab to open it 

• Left click on the Table button 
o In the Table popup, navigate to the Read CSV table 

• Left click on the Filter button 
o In the Filter popup, navigate to Ticks filter under the table map created in Step 05 

• Left click on the ID button 
o In the Set ID popup, set the ID to Lith_ID 

• Left click on the X button 
o In the X popup, set the X-Values to the EQ_RMR Bins (+ lith offset) row 

calculation output from Step 13 

• Left click on the Y button 
o In the Y popup, set the Y-Values to the Count for the PDF Complete table 

accumulation created in step 12 

• Tick the Multiple Lines Group By box 

• Left click on the Multiple Lines Group By button 
o In the Group (1) popup, set the Group to the Lithology under the Read CSV 
o In the Group (2) popup, set the Group to the Sort EQ_RMR into Bins Row 

Calculation output from step 11 
 
Note: This chart differs from the chart in Step H only in the X-Axis values it uses. 
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The Chart should look something like this. 
 
Note: This chart changes depending on the ticks in the Distinct Lithology Table 
 
Note: The lithologies are slightly offset from each other. Once marker styles are applied (later in 
the walkthrough) the purpose of this offset will become particularly apparent. 

 
Left Click the Configure Page button and Save the Tool 
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Application Progress (Section 6) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

A PDF function has been created using a combination of a row calculation and an accumulation. This 

PDF is displayed using various charts, with the last of three charts filtered using the ticks from the 

Distinct Lithologies Table. The lithologies on the chart are also offset (using a row calculation) to make 

it easier to view the data for each lithology 

 

 

In the next section, Marker Styles will be created. These Marker Styles will be applied to the charts 

and tables that will be included in the final application. 
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7. Markers 

Settings Step 14 – Marker Style created for each lithology 
Marker style tools are used in the Analysis Window and determine the marker colours and shapes 

used to visualise the data. 

Create and Save a new *Marker Style tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 14 – Marker Style for Lithology 

 
Left click on the Scheme dropdown and set the scheme to Symbol-colour scheme: Use a range of 
markers and colours 
In the Short Label for Legend textbox, give the marker an appropriate name such as “Lithologies” 
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Left click on the Basics tab to open it 
Left click on the Input button, in the Choose Marker Input popup  

• In the Tables section, navigate to the CSV table 

• In the Columns in Table section, add in the Change LithID to Number row calculation 
output from Step 06 

 
Left click on the Maximum button, in the Fixed Maximum popup  

• In the Tables section, navigate to the Distinct Lithology Table 

• In the Columns in Table section, navigate to the Maximum 
 

Left click on the Minimum button, in the Fixed Minimum popup  

• In the Tables section, navigate to the Distinct Lithology Table 

• In the Columns in Table section, navigate to the Minimum 

 
Left click on the Ranges tab to open it 

• Double left click on the Colour Ramp and select Linear 

• Double left click on the Start Colour and End Colour and choose an appropriate colour for 
each 

 
Save the Tool  
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Settings Step 15 – Creating a new Marker Style for the Distinct Lithology Table 
This marker style will give a unique colour to each of the lithologies. 

Create and Save a new *Marker Style tool 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation  
Name: Step 15 – Marker Style for Distinct Lithology Table 

 
Left click on the Scheme dropdown and set the scheme to Symbol-colour scheme: Use a range of 
markers and colours 
In the Short Label for Legend textbox, give the marker an appropriate name such as “Lithologies” 
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Left click on the Basics tab to open it 
Left click on the Input button, in the Choose Marker Input popup  

• In the Tables section, navigate to the Distinct Lithology Table 

• In the Columns in Table section, add in the Change LithID to Number row calculation 
output from Step 08 

 
Left click on the Maximum button, in the Fixed Maximum popup  

• In the Tables section, navigate to the Distinct Lithology Table 

• In the Columns in Table section, navigate to the Maximum 
 

Left click on the Minimum button, in the Fixed Minimum popup  

• In the Tables section, navigate to the Distinct Lithology Table 

• In the Columns in Table section, navigate to the Minimum 

 
Left click on the Ranges tab to open it 

• Double left click on the Colour Ramp and select Linear 

• Double left click on the Start Colour and End Colour and choose an appropriate colour for 
each 

 
Save the Tool  
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Application Progress (Section 7) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

Markers have now been created. These will be added in to the relevant charts and tables after the 

interface tools have been completed. 

 

 

In the next section, the application interface tools will be created. 
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8. Interface 

Interface submenu 
The interface is a set of tools created for the purpose of building the frontend of the app. To 

differentiate from the tools previously created in the Settings Window, it is advised to save the tools 

created for the interface under a new submenu (named @interface in this case) 

The Analysis Tools will be saved in the root folder under the directory:  

#Beta Modules/IGM Rock Property Statistics Visualisation Example/@interface 

Each interface step (Settings window) will be saved Numerically eg Step 16 – Marker Style Menu 

Settings Step 16 – Creating a Variables Panel for the App 
Variables panels are created for the user of the app to change a set of predefined parameters. In this 

case, this variables panel will be set up to allow the user to change the input CSV file within the app 

instead of necessitating the use of the Settings Window. 

Create and Save a new *Panel View tool under @interface 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation/@interface 
Name: Step 16 – Marker Style Menu 
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Left click on the Items tab to open it 
Left click on the Add dropdown and add a Variable Editor  
Left click on the Variable Editor item 
Left click on the Variable to edit button 
In the Choose Variable popup 

• Under the Tables section, navigate to the Variable table created in Step 02 

• Under the Columns in Table section, navigate to the Filename variable column 

 
Left click on the Items tab to open it 
Left click on the Add dropdown and add a Embed a tool (another Panel, Pick, Table View)  
Left click on the Tool (Table/Pick/Panel) item 
Left click on the Tool/Panel View to show button 
In the Tool/Panel View to show dropdown list, navigate to the Distinct Lithology Tableview 
created in Step B using the following route 

• Table Views >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step B – 
Distinct Lithology Tableview 

 
Save the Tool 
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Settings Step 17 – Creating a Menu Definition for the Marker Styles 
Menus contain items that have been created in the Settings and Analysis Windows. In this case, the 

Menu Definition will contain all of the marker styles that have been created. This menu will later be 

added in to the analysis tools that will be used in the app. 

Create and Save a new *New Menu Definition tool under @interface 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation/@interface  
Name: Step 17 – Marker Style Menu 

 
Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the Marker Style created in Step 14 using the following route 

• Marker Styles >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step 
14 – Maker Style for Lithology 

When prompted, name the tool “Lithology ID” 
 
Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the Marker Style created in Step 15 using the following route 

• Marker Styles >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step 
15 – Maker Style for Distinct Lithology Table 

When prompted, name the tool “Distinct Lithologies”  

 
Save the Tool 
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Settings Step 18 – Creating a Menu Definition for the Analysis Tools created 
This menu definition contains all of the analysis tools to be displayed in the app as well as any controls 

that need to be included into the app. 

Create and Save a new *New Menu Definition tool under 
@interface 

 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation/@interface 
Name: Step 18 – Marker Style Menu 

 
Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the CDF chart created in Step E using the following route 

• Charts >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step E – CDF 
per Lithology (ticks filtered) Chart 

When prompted, name the tool “Charts/CDF of EQ_RMR” 
 
Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the PDF chart created in Step I using the following route 

• Charts >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step I – PDF 
per Lithology (ticks + offset) Chart 

When prompted, name the tool “Charts/PDF of EQ_RMR” 
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Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the Panel View created in Step 16 using the following route 

• Panel Views >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step 16 
– Variables Panel 

When prompted, name the tool “Panels/Controls” 

 
Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the Table created in Step F using the following route 

• Table Views>> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step F – 
Statistics per Lithology Tableview 

When prompted, name the tool “Tables/Lithology Summary” 
 
Right click in the Menu Definition window 
Left click Add New Tool 
In the dropdown list, navigate to the Table created in Step C using the following route 

• Table Views>> #Beta Modules >> IGM Rock Property Statistics Visualisation >> Step C – 
Complete Table (ticks filtered) Tableview 

When prompted, name the tool “Tables/RAW Data” 

 
Save the Tool 

 



mXrap – Rock Properties App Creation Walkthrough 

81 
 

Settings Step 19 – Creating a Window Definition 
Each app requires at least one window, but can have many windows. This allows for each window to 

be focussed on a specific task. Separation of tools into appropriate windows helps to avoid 

unnecessary clutter. 

Create and Save a new *Window Definition tool under @interface 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation/@interface 
Name: Step 19 – Analysis Window 

 
Left click on the Menu Definitions tab to open it 
Left click on the Menu Definition button and navigate to the Menu Definition created in Step 18 
using the following route 

• Menu Definitions >> #Beta Modules >> IGM Rock Property Statistics Visualisation >> 
Step 18 – Analysis Tools Menu 

 
Save the Tool 
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Settings Step 20 – Creating an App definition to complete the App build process 
Finally, the app definition simply contains all of the windows that should be included into the 

application. 

Create and Save a new *App Definition tool under @interface 
 

 Folder: #Beta Modules/IGM Rock Property Statistics Visualisation/@interface 
Name: Step 20 – App Definition 

 
In the Title textbox, enter an appropriate app name. For this walkthrough, the name is: 
“IGM ---> Rock Properties Statistics Visualisation” 
 
Right click in the Menu Definition window 
Left click Add New Window 
In the dropdown list, navigate to the Window Definition created in Step 19 using the following 
route 

• Window Definitions >> #Beta Modules >> IGM Rock Property Statistics Visualisation 
>> Step 19 – Analysis Window 

When prompted, name the tool “Rock Properties Window” 
 
Double left click on the Window Definitions Open at Start column, and set it to True 

 
Save the Tool 
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Application Progress (Section 8) 
The tool tree in the Settings Window should now look as follows. Following the naming convention 

will make it easier to follow the walkthrough steps. 

 

The interface is now complete. 

 

 

In the next section, the marker styles will be applied to the application charts and tables. 
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9. Applying LithoID Markers 

Analysis Step C Continued – Adding Markers to Complete Ticks Table 

Open the Complete Table with Ticks Tableview 
 

 
Left click on the Configure Page button 
In the Configure page popup: 

• Tick the Marker Menu box 

• In the Marker Menu dropdown, navigate to the Marker Menu created in Step 17 using 
the following route 

o Menu Definitions >> #Beta Modules >> IGM Rock Property Statistics 
Visualisation >> Step 17 – Marker Style Menu 

• Tick on the BHID, Lithology, Eq_RMR, From and To columns to show them in the table. 
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Right click on the Lithology column heading and then left click on Configure marker style 

 
The table should now look something like this 

 
Left Click the Configure Page button and Save the Tool 
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Analysis Step E Continued – Adding Markers to CDF Chart 

Open the CDF per Lithology (ticks filtered) Chart 
 

 
As before, left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• In the Series tab, left click on the Markers tab 

• Tick the Marker Menu (colours/shapes) 

• Left click on the Marker Menu button 

• In the dropdown, navigate to the Marker Styles menu definition using the following route 
o Menu Definitions >> #Beta Modules >> IGM Rock Property Statistics 

Visualisation >> Step 17 – Marker Style Menu 

• In the Series Name text box, give the series an appropriate name 
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Tick the Marker As box to view the new Marker Style 

 
Left Click the Configure Page button and Save the Tool 
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Analysis Step I Continued – Adding Markers to PDF Chart 

Open the PDF per Lithology (ticks + offset) Chart 
 

 
As before, left click on the Configure Page button 
In the Configure page popup: 

• Left click on the Series tab 

• In the Series tab, left click on the Markers tab 

• Tick the Marker Menu (colours/shapes) 

• Left click on the Marker Menu button 

• In the dropdown, navigate to the Marker Styles menu definition using the following route 
o Menu Definitions >> #Beta Modules >> IGM Rock Property Statistics 

Visualisation >> Step 17 – Marker Style Menu 
In the Series Name text box, give the series an appropriate name 
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Tick the Marker As box to view the new Marker Style 

 
Left Click the Configure Page button and Save the Tool 

 

  



mXrap – Rock Properties App Creation Walkthrough 

90 
 

10. Applying Distinct Table Markers 

Analysis Step B Continued – Adding Markers to Distinct Lithology Table 

Open the Distinct Lithology Tableview 
 

 
Left click on the Configure Page button 
In the Configure page popup: 

• Tick the Marker Menu box 

• In the Marker Menu dropdown, navigate to the Marker Menu created in Step 17 using 
the following route 

o Menu Definitions >> #Beta Modules >> IGM Rock Property Statistics 
Visualisation >> Step 17 – Marker Style Menu 
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Right click on the Lithology column heading and then left click on Configure marker style 

 
The table should now look something like this 

 
Left Click the Configure Page button and Save the Tool 
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Analysis Step F Continued – Adding Markers to Statistics per Lithology Tableview 

Open the Statistics per Lithology Tableview 
 

 
Left click on the Configure Page button 
In the Configure page popup: 

• Tick the Marker Menu box 

• In the Marker Menu dropdown, navigate to the Marker Menu created in Step 17 using 
the following route 

o Menu Definitions >> #Beta Modules >> IGM Rock Property Statistics 
Visualisation >> Step 17 – Marker Style Menu 
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Right click on the Lithology column heading and then left click on Configure marker style 

 
The table should now look something like this 

 
Left Click the Configure Page button and Save the Tool 
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11. Application 

Launching your App 
Once the app has been built, it should appear in the mXrap launcher.  

In the Launcher, left click Reload Config to refresh the Launcher 
The app should now appear under the correct root under the Home/Admin Role 
Double left click to open your newly created app 
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Selecting what you want to see in your App 
The user can open the various charts and table views in tabs within the app workspace. The panels 

created can also be opened and should display to the left of the workspace. 

The charts, table views and variables panels created under the @interface will now be accessible 
in your app 
In the App menu 

• Charts – Select the charts you want to view 

• Panels – Select the panels you want to view 

• Table views – Select the table views you want to view  

 

 
 

You should see something like this in your app after opening a few tools 
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Saving the opened tabs so they appear every time the app is opened 
The tabs opened by the user can be saved, allowing for the blank workspace to be configured as 

required. 

In the App Menu: 

• Click Windows and go to Settings Window 

 
In the Settings Window: 
Open the Analysis Window Menu Definition tool created in Step 19 
Left click the Initial Tabs tab to open it 
Tick the “Enable initial tabs capture”. 
 
Now go back to the App window. In the App Menu: 
Left click File and then click Capture Initial Tabs 

 
Go back to the Settings Window with the tool created in Step 19 still open. Save the tool. 
 
Your app will now open the same tabs that you’ve just saved every time you open the app. 
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